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Introduction to Excelsior 
 
Market Insight Excelsior provides a reporting environment which combines 
the analytical power of Market Insight to process huge marketing databases 
with the flexibility of Excel to manipulate and present data driven results. 
 
Market Insight Excelsior has two licensing levels: 

 Excelsior Developer - small number of individuals who actually 
assemble the Excelsior reports in tandem with Market Insight   

 Excelsior Viewer - larger number of individuals who can view and 
refresh the Excelsior reports with the latest results, but cannot alter 
the structure of the report   

An Excelsior report is based on a number of embedded Market Insight 
Objects (e.g. a cube), which are linked to the Market Insight system and can 
be refreshed with the latest results. 
 
Typically the Developer would use Excel functionality (e.g. formulae and 
charts) to manipulate the raw data and present it in an attractive format for 
the Viewers. 
   
There is the opportunity to incorporate external data within the Excelsior 
workbook, for example, using some budget or target figures. 
 
The Excelsior Report maintains a link to the Market Insight system so that 
the report can be refreshed to reflect the latest data. 
   
The link between Market Insight and Excelsior is held as part of the plugin to 
Excel.  Therefore when the report is saved it can be shared as a snapshot of 
the results, as there is no longer a link with the Market Insight system.  An 
unlimited number of individuals throughout the business can use Excel, 
without the Excelsior plugin to view a report in this way.   
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The Example Data 
 
The structure of your Market Insight system can vary.  The elements shown 
here are typical – each Site may be simply flagged with Customer data or can 
have many related Contacts.  A Site may also have many matched Customer 
Accounts, and / or many other types of related data (such as one or more 
URLs, UCC Filings and Corporate Family Linkage Plus entries, etc.)  The data 
loaded for each matched Customer Account is configurable – for example 
you may have multiple Transactions or Divisional Summaries or Product 
Summaries etc. 
  
The detail present on each table of data depends on the Market Insight 
Administrator.  The data is arranged into folders to assist the user to 
navigate and find data items. 
 
 
The structure used in the Training System, illustrated in this manual, uses a 
simple structure that has sample customer data and contact tables that are 
linked to a Sites table and these sites are in turn linked to the Global 
Ultimate Sites table (e.g. worldwide headquarters). 
 
 

N.B. The counts and displays in this manual may well differ to the 
results you obtain due to the changing nature of the data.  
 
 

Using This Manual 
 
This manual is designed to act as a self-directed training course using the 
data described above or as a reference guide.  Therefore you will not 
necessarily see the same figures as shown in this manual when working 
through the examples. 

 
 
 
 

 

 
                                                              Training System Table Level Structure 

 
 
 
 
 
 
 
 

 
 

N.B.  This manual is not 
designed to provide Excel training. 
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How to Login 
 

Opening a Report 
 
As a Developer or Viewer you can open an existing Excelsior report by 
opening it up through a version of Excel that has the Excelsior plugin 
installed.  As a Developer you can create a new Excelsior report by logging in 
to the Excelsior plugin of Excel: 
 

 Open Excel and click on the Market Insight Excelsior ribbon bar tab 
and then click on the Show Task Pane button 
 

Connecting to the Market Insight System 
 
The Excelsior Report is essentially an Excel workbook, with links to a Market 
Insight system in order to retrieve the latest data.  The contents of the report 
when opening it will be a snapshot of the results when the report was last 
saved.  A connection to the Market Insight system is required in order to 
refresh the results.  There is a task pane on the right hand side of the 
workbook which connects the Excelsior report to the Market Insight system 
on which it is based. 
 

Remote Login 
 
Typically multiple users will view Excelsior reports that connect to a Market 
Insight system stored remotely.  Your Market Insight Administrator will be 
able to set you up with an Excelsior Username and Password and provide 
you with the login details of the System name and Web Service address.  This 
username will determine your level of access as a Developer or a Viewer. 
 
 
 
 
 

  
 
 
 
 
 

 
                                        Enterprise Login 
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Viewing an Existing Excelsior Report 
 
To view an Excelsior report you have been sent (or created yourself) as an 
Excel file, you will need to save it on your local hard drive. 
   
An Excelsior Viewer is able to log in to the Market Insight system and refresh 
the contents of the report at any time.  
 

 From the File menu of Excel locate the .xlsm file that you wish to 
open (you may not have one yet) 

 
 Open the file 

 

Viewing the Report 
 
The contents of the report when opened will be a snapshot of the results 
when the report was last saved.   
 
The report layout and display will be dependent upon the Excel skills of the 
Excelsior Developer.  The aim will be to present clearly information found or 
derived from Market Insight.  How these Market Insight objects are created 
and selected for use in Excelsior is shown later in this manual. 
 
An Excelsior Viewer has two main options when using Excelsior: 
 

 Refresh – to retrieve the current figures 
 

 Save – to obtain a standalone copy of the report 
 
The final option is to Log off from Excelsior which breaks the connection with 
the Market Insight system with which the report was generated. 
 
 
 
 

  
 

 
                                Refreshed Excelsior Report 

 
 

 
                                             Refresh & Log off Buttons 
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Refresh the Report 
 
You are already aware that your Excelsior report is a snapshot in time.  
Therefore when the Market Insight database has been refreshed you will 
want to see this reflected in your report. 
 
To achieve this action: 
 

 Click the Refresh all button 
 
The various Market Insight objects used within the report will be listed in the 
Refresh window.  As the refresh takes place you will notice the report display 
change as new figures are inserted and graphs updated. 
 
 
 
 
 

Logoff 
 
To disconnect from the Market Insight system: 
 

 Click the Log off button 
 
The Excelsior Report will remain open so that normal Excel functionality can 
still be used.   
 
The report can be saved (as a snapshot in time) and shared with Excel users 
who do not have the Excelsior plugin. 

  
 

 
                                                           Excelsior Panel 
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Developing an Excelsior Report 
 
To be able to create an Excelsior Report you will need an Excelsior Developer 
license.  The following information gives you an overview of what is available 
to an Excelsior Developer. 
 
The Excelsior panel is split into 2 sections, Insert and Refresh.  The Insert 
section gives the Developer access to the data in the associated Market 
Insight system. 
 

File This option gives you access to the My Market Insight Folders 
of your Market Insight system.  Here you can locate any saved 
items you need e.g. cube, venn etc.  

  
Variable This option gives you access to the System Explorer of your 

Market Insight system.  Here you can locate any variables you 
wish to gain access. 

  
Other This option allows you to insert 2 useful dates into your 

report; the refresh date of your report and the date of system 
build. 

  

 
                           Insert Section of Excelsior Panel 

  

 
 
The Refresh section allows you to refresh, delete and amend options on the items 
in your report.  The label to the left of the vertical line indicates the sheet of your 
workbook (even those that are hidden).  The items listed to the right of the vertical 
line relate to the sheet selected. 
 

Delete Clicking on this button will delete the highlighted item.  You will 
also need to delete the actual display on the report. 

  
Refresh Clicking on this button will refresh the display for the highlighted 

item. 
  
Refresh All Clicking on this button will refresh all the items, on all the sheets 

of the report. 
  
Log off Clicking this button will sever the link between the Excelsior 

plugin and the Market Insight system. 
 
 

 
                                                   Refresh Section of Excelsior Panel 
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Starting a new Excelsior Report 
 
To create a new Excelsior Report you will need to open a new blank 
workbook. 
 

 From the File menu select New → Blank workbook and then click 
Create 

 
The Excelsior Developer can use the powerful analysis tools available in 
Market Insight to prepare the report.  
  

 In Market Insight you can create any of the Market Insight Objects 
listed opposite and save them in the My Market Insight Folders.  
(These objects will need to be saved in the Public folders if the 
Excelsior report is to be accessed by multiple users). 

 In Excelsior, the saved objects are visible in the File section of the 
Insert panel. 

 You can select a cell in a worksheet where the object is to be 
inserted, and double-click on the reportable or use the Insert button. 

 
The latest results from the Market Insight system are inserted on to the 
selected worksheet.  Excel functionality can then be used to manipulate and 
present the results inserted from the Market Insight system.  The results can 
be updated at any time keeping the reports up to date with the latest data in 
the system. 
 
 
The Market Insight objects shown opposite can be embedded in an Excelsior 
report: 

  
 

 
          New Excelsior Window 

 
 

 

 Cubes/Trees 

 Word Clouds 

 Venn diagrams 

 Data Grids 

 Selections (saved as a Query) 

 Maps 

 Profiles 
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Creating an Excelsior Report 
 
To guide you through the developing process a series of Market Insight 
Objects have been created and placed into a folder called Reportables.  The 
following pages will demonstrate how you can insert objects into the 
Excelsior Report and use some basic Excel functionality to create a simple 
dashboard. 
 
 

N.B. This is not an Excel training course so you will need to use your own 
skill and knowledge to manipulate and display the data to the required 
standard when creating your own reports. 
 
 
When using the various Market Insight Objects you may want to manipulate 
them within Excel.  Therefore you may want to insert different objects into 
different worksheets before displaying the end results. 
 

 Right click on the Excel Sheet1 tab 
 

 Select Rename and type Dashboard 
 

 Click on cell B1 and type Company Product A Dashboard in font 
Calibri 24 

 
 Save your Excelsior Report on the Desktop as My Excelsior 

Dashboard.xlsm 

  
 
 

 
                                                Logged in Excelsior Panel 
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Working with Market Insight Objects 
 
Before using some predefined Market Insight Objects, create a cube in 
Market Insight to demonstrate the start to end process.  (You will require 
access to the Market Insight Training system to do this.) 
 

 Create a Cube of the entire Training database.  Display as a 
breakdown of Banded Company Employee Model  by Country Code 
at the Records table 

 
 Save the Cube as Number of Employees by Country in your Private 

folder (generally save your objects in your Reportables folder) 
 

 In Excelsior click on cell A1 in Sheet2 
 

 In the Insert panel click on the  Refresh button then highlight the 
Banded Company Employee Model file 

 
 Click Insert as Data 

 
The results found in Market Insight are now represented in the Excelsior 
Report.  In the Refresh panel there are buttons to: 
 

Refresh 
 
This option will retrieve the latest results from the Market Insight system and 
display them in the same position the object was placed on the Excelsior 
report. 
 

Delete 
 
With the Market Insight Object highlighted in the Refresh panel, pressing the 
Delete button will remove it from the report. (Do not do this now) 
 

  
 

 
                          Cube – Number of Employees by Country 

 
 

 
                                                             Insert Panel 
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When the mouse pointer is over the Market Insight Object in the Refresh 
panel a small arrow is revealed.  Clicking on this arrow will present you with 
the Options screen for that object. 
 
 

Find 
 
Clicking on this button will highlight the object’s display in the report. 
 

Apply 
 
Use this button to activate the options once a mark has been placed in the 
relevant tick boxes. 
 

Reset 
 
Click this button to restore the default options, as seen in the screen shot 
opposite. 
 
 
Click on the arrow at the top of the screen to return to the Refresh panel. 
 
 
 

 Delete this object and return to the Dashboard tab 

 
 
 

 
                                         Market Insight Object - Options 
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Working with Cubes and Trees 
 
Cubes and Trees provide a powerful tool for aggregating your data.  By using 
Market Insight Excelsior further data manipulation can be performed on the 
results (e.g. indexing, cumulating, and averaging) or results can be combined 
with data from external sources.  Excel charts can be applied to Cubes or 
Trees to present results visually. 
 

Inserting Cube Data 
 
Any cube saved in Discoverer can be inserted into an Excelsior report either 
as an Excel Pivot Table, Source or the Cube Data (static table layout). 
 

 Click on cell J5 on the Dashboard where you want to insert the cube 

 Select the cube saved in Discoverer from the Insert panel – Public → 
Reportables → Mean Customer Revenue.xml 

 Choose Data (static table) rather than Pivot (dynamic Excel Pivot 
Table) and click Insert 

 
The latest results of this cube will be inserted at the selected cell.  The 
Refresh panel will also list the cube that has been inserted.  
 
To tidy up the display it would be useful to hide the Unclassified row and 
wrap the Mean (Customer Leve Revenue) text. 
 

 Right click on the Row(s) and select Hide 
 

N.B. You cannot just delete elements of your Market Insight Object 
because when you refresh the display the original columns/rows, plus any 
new ones will be reinstated into that same position.  
 
 
 

 
 

 

 
                                         Insert Cube Data 

 
 
 

 
                                            Cube Results in Excelsior 
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 Click on Mean (Customer Level Revenue) and wrap text, also from 

the Home button change the number on this from General to 
Currency if necessary 

 
 Resize Column J and on Row 5 type Region 

 
 Highlight the entire table remove the Coral shading and from the 

Styles group on the Home tab click on Format as Table 
 

 Click on the Table Style you prefer and click OK 
 
 
 
The formatting you have applied to these cells will be retained the next time 
a refresh takes place.   
 

N.B. This method is best used for objects where the number of 
categories is unlikely to change.  Otherwise insert as a pivot table so you can 
always find the same categories.  See the examples on the following pages. 
 
To present some of this information as a chart: 
 

 Highlight the Regions and Mean (Customer Level Revenue) for 
North, West Midlands and South East (Inside M25) 

 
 Click on the Insert ribbon 

 
 
 
 
 

 
 
 
 

 

 

                                     Cube Data with Formatting 

 

 

 
                                 Continent & Mean Spend Highlighted 

 



 
D&B Market Insight User Training Manual 

D&B Ltd © 2009 - 2017  13 

 
 From the Charts group click on the Bar button 

 
 Select your preferred option 

 
 Format the chart as you wish 

 
 Highlight Chart Title and name the chart Selected Regions 

 
 
You can now resize and position the chart to an appropriate place on the 
report. 
 
 

 Drag the chart so it sits to the left of the table of figures  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
                       Chart of Selected Regions 

 

 
              Chart & Data Displayed Side by Side 
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Inserting a Cube as a Pivot Table 
 
Any cube saved in Market Insight can be inserted into an Excelsior report 
either as an Excel Pivot Table or the Cube Data (static table layout). 
 

 Click on cell A1 on Sheet2 where you want to insert the cube 

 Select the cube saved in Discoverer from the Insert panel – Public → 
Reportables → Region by Product.xml 

 Choose Pivot table (dynamic Excel Pivot Table) rather than Data 
(static Cube table) and click Insert 

 
A Pivot Table will be inserted at the selected cell to display the latest results.  
  

Configuring the Pivot Table 
 
The Pivot Table may need configuring (see Excel help for more details on this 
functionality).  For example: 

 Change Field Value Settings to display values as Sum or Count. 

 Change Field Value Settings to display values as % Row or Column 
etc. 

 Change the orientation of rows and columns. 

 Use Filters to hide certain categories. 
 
These configurations will be maintained when the Pivot Table is refreshed. 
 
 
 
 
 
 
 

  
 

 
                                             Insert Panel 

 

 
                       Cube Displayed as a Pivot Table 
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To create a simple, but flexible chart: 
 

 Click within the pivot table and then from the Options ribbon click 
on the Pivot Chart from the Tools group 

 
 Select the Clustered Column chart and click OK 

 
You now have the opportunity to choose which items you would like to 
display on your chart: 
 

 On the PivotTable Field List click on the drop down arrow on the 
Economic Region field.  Deselect all destinations except North, West 
Midlands, and South East(Inside M25) 

 
 On the PivotTable Field List click on the drop down arrow on the 

Policy Product Type field.  Deselect No Policies 
 

 Click on the chart, the Design ribbon should now be displayed.  From 
the Charts Layouts – Quick Layouts select Layout 3 

 
 Click on the title and amend as shown in the screen shot opposite 

 
 Click on the Move Chart button on the ribbon bar, select Object in: 

Dashboard and click OK 
 
You can now drag the chart to an appropriate place on the dashboard. 
 

 Resize the chart and place the top left corner around cell I24 on the 
dashboard 

 
As mentioned above, once a Market Insight object has been inserted into an 
Excel worksheet as a Pivot Table you have a great deal of functionality 
available to you.  Unfortunately these further options are outside the scope 
of this training course. 
 

 

 
                                 PivotTable Field List 

 
                                  Pivot Chart of Target Regions 
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Inserting a Tree 
 
A tree has the same underlying structure as a cube, but is usually displayed 
in hierarchical form.  The advantage of a Tree is that it is more efficient at 
storing multi-dimensional data where there are large numbers of 
unpopulated combinations. 
  
A Discoverer Tree can be inserted in the same way as a Cube, with the 
following options: “Tree” (flattened form) or “Pivot” (dynamic Excel Pivot 
Table). 
 
The examples shown above could equally apply to Trees, as would the 
following example apply to using a Cube. 
 

 Click on cell A1 on Sheet3 where you want to insert the Tree cube 

 Select the Tree saved in Market Insight from the Insert panel – 
Public → Reportables → Region Lapsed or Live.xml 

 Choose Pivot table (dynamic Excel Pivot Table) rather than Data 
(static table) and click Insert 

 Use the filters to deselect regions not of immediate interest 

 

Calculations based on Cube or Tree results 
 
The difficulty of formatting and presenting some data is that the source 
information location on a worksheet might change when an update takes 
place.  New categories or variables may be included so that the position of 
figures may now be in a different position to when you originally set up your 
display. 
 
The GetPivotData function provides a useful way to extract data from a Pivot 
Table by naming the information you want so it can be found despite 
changes made by a Refresh. 
 

  
 

 

 
                     Tree Displayed as a Pivot Table 
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 Click on cell B28 on the Dashboard and type North 

 
 Complete the remainder of the table headings as shown opposite 

 
You have now setup the format of the display you would like to see on your 
Dashboard.  Next you need to associate each cell with where the data is held 
within the Pivot table on Sheet3. 
 

 In cell C28 type = and then click on the cell in Sheet3 that gives the 
North, Product A, Live figure.  Press Return 

 
 Click on cell C28 and in the Excel formulae bar change the section 

“North” with the cell reference for the heading North – B28 
 
=GETPIVOTDATA("Records",Sheet3!$A$1,"Economic Region",B28,"Policy 
Product Type","PRODUCT A","Policy Status","Live") 
 
This action has now referenced the name North so it will find this data 
anywhere in the pivot table.  
 

 Click on the small black box on the bottom right of the cell and drag 
down to populate West Midlands and South East (inside M25) 

 
 Repeat the above process for the Product B, C and D columns 

 
 Add a title and formatting to your table 

 
 
The figures shown opposite will be different to what you see. 

 

 

 

 

 

 

 

 

 
        Table with formatted figures  
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Inserting a Venn 
 
A Venn diagram can be inserted into an Excelsior report as an image. 
 

 Click on cell B43 on the Dashboard where you want to insert the 
Venn file 

 Select the Venn file saved in Discoverer from the Insert panel – 
Public → Reportables → Policy Crossover.xml 

 Click Insert 
 

 Add a title and borders as desired 
 
You can now drag the image around the report and resize if required.  When 
the Venn is updated the latest counts will be displayed and the Venn diagram 
optimized for the new size. 
 
 
 
 

  
 

 
                                            Insert Panel 

 

 
                                           Venn Image 
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Inserting a Data Grid 
 
A Data Grid can be inserted into an Excelsior report as a table of data. 
 

 Click on cell H2 on the Sheet2 where you want to insert the Data 
Grid cube 

 Select the Data Grid saved in Market Insight from the Insert panel – 
Public → Reportables → Top 5 Businesses by Revenue.xml 

 Click Insert 
 
To present this information on the main Dashboard you may want to pick 
and choose certain items of data 
 

 Click on cell J43 on the Dashboard where you want to insert the 
information 

 
 Type = and click on the first Business Name cell on Sheet2 

 
 Press Return to see the result 

 
 Click on the small black box on the bottom right of the cell and drag 

down a further 4 cells 
 
The Top 5 Business Names are now displayed. 
 

 Type = in the cell next to your first Business Name.  Click on the 
appropriate Town and County name in Sheet2.  Press Return 

 
 Click on the small black box on the bottom right of the cell and drag 

down a further 4 cells to replicate the formulae and show the figures 
 

 Repeat for Customer Level Revenue and then add some appropriate 
headings and a title and format the figures 

  
 
 

 
                                               Insert Panel 

 
 
 
 

 

 
                 Formatted Details of Top 5 Businesses 
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Inserting a Selection Count 
 
The count from a selection can be inserted into a single cell anywhere on the 
report.  In the following example you will insert a count of the total number 
of Sites currently licensed by the organization. 
 

 Click on cell J2 on the Dashboard where you want to insert the count 

 Select the count saved in Discoverer from the Insert panel – Public 
→ Reportables → Current Live Customers 

 Click Insert 

 

You may want to give your figure a label: 

 Click on cell J1 and type Live Customers 

 

Use the Format Cells option in Excel to make the best display of the label and 
figure. 

 

 Right click on the cell and select Format cells… 

 

 

  
 

 

 
                                                  Insert Panel 

 
 
 

 
                                              Count Figure Inserted in Excelsior 
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Inserting Variable Categories and Counts 
 
A list of categories and the full system counts can be inserted anywhere on 
the report.  In the following example you will insert the Destination variable. 
 

 Click on cell O2 on the Dashboard where you want to insert the 
variable 

 Select the variable in Market Insight from the Variable section of the 
Insert panel – Sample Customer Data → Customer Data Status 

 Click Insert 
 
You can now format the display using Excel and Excelsior options. 
 

 Click on the arrow which appears when you mouse over the 
Customer Status variable in the Refresh panel 

 
 Deselect the Show codes check box 

 
 Click Apply 

 
 Refresh the Customer Status variable in the Refresh panel 

 
 Add an appropriate title i.e. Breakdown of Licensed Sites 

 
 
 
 

  
 

 
                                               Insert Panel 

 

 
                                                         Variable Options Window 
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Inserting a Word Cloud Image 
 
A Word Cloud image can be inserted anywhere on your report. 
 

 Click on cell I51 on the Dashboard where you want to insert the 
Word Cloud image 

 Select the Word Cloud saved in Market Insight from the Insert panel 
– Public → Reportables → Policy A by Channel.xml 

 Click Insert 
 
You can now drag the image to an appropriate place on the report and add a 
title. 
 
 
 
 
 
 

Inserting a MapPoint Image 
 
A Microsoft MapPoint image can be inserted anywhere on your report.  In 
the same manner as described above for the Word Cloud. 
 
 

N.B. Using Venn, Word Cloud and MapPoint objects will always result in 
an image of the item  
 
 
 
 
 
 
 

  

 
                                                      Insert Panel 
 
 

 

 
                                    Word Cloud Image 
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Inserting a Refresh Date/System Build Date 
 
An Excelsior Tool available to insert into a report is the Refresh Date.  This 
date tells you the last time you updated the report.  However, if the Market 
Insight database has not been refreshed then the same figures will be 
returned.  In addition you may wish to also display the System Build date 
 

 Click on cell L2 on the Dashboard where you want to insert the 
Refresh Date 

 Select the option Excelsior refresh date from the Other section of 
the Insert panel 

 Click Insert 
 

 Add a title in cell L1 – Refresh Date 
 
Apply formatting to the title and date as appropriate. 
 

Finishing Touches 
 
To complete your report for final presentation you may want to hide the 
gridlines or even change the color of the background: 
 

 In Excel go to the View ribbon and then the Show group 
 

 Untick the Gridlines box 
 

 Highlight the whole worksheet, right click and select Format Cells 
 

 From the Fill tab select a light color and click OK 
 
You may need to readjust other colored headings already applied. 

  
 

 
                                              Insert Panel – Other Section 

 
 
 

 
        Company Policy Product Dashboard 
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Using Parameterized Selections 
 
Parameterization in Market Insight allows a User to determine the values used within a 
selection.  This function can be taken advantage of within Excelsior to allow the Viewer to 
filter the display by the parameterized variable categories. 
 
In this example you are going to use the Region variable as a mechanism to filter a Data 
Grid representing a selection of bookings. 
 

 On Sheet 3 of the report click on cell J12 
 

 Select the State variable in Market Insight from the Insert panel – Variable 
section →  Geography → Region and click the Insert button 

 
 Hide column J and L (this will tidy up the display) 

 
 Highlight the cells in column M next to the Region descriptions 

 
 In the Name Box enter Region as the name for the range of cells and press Return 

(N.B. This must be the same name as the parameterized item) 
 
To select a Region or Regions the Viewer could just type the relevant Region code in one 
of the cells just defined.  To make this process more User friendly we will use the following 
formula to test for an entry in column G next to the relevant State to select the relevant 
code. 
 

 Highlight cell M13 and type the following in the Formula Bar: 
 
            =IF(I13<>””,TEXT(J13,”00”),””) 
 

 Copy the cell down against the other regions 
 
 
 
 

  
 
 
 

 
                                Insert Panel – Variable Section 

 
 
 
 
 
 

 
                          Parameterized Formula 
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 Hide column M and then put an x in cell I3 against Scotland 
 

 Click on cell O13 and then highlight the Top 10 Records by Premium Volume Data 
Grid from the Insert panel.  Click Insert 

 
 
 
Each time you add or change the range selected you will have to highlight the item in the 
Refresh panel and click on the Refresh button to see the updated results. 
 
To use this functionality for all of the Market Insight Objects in your Report, you will need 
to ensure that the variable (State in this case) is parameterized in the selection of each 
item.  
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Refreshing the Whole Report 
 
The Refresh All button can be used to refresh all the Market Insight Objects 
in the report. 
 
The Refresh panel displays each object and shows the progress as they are 
updated. 
 

Development Considerations 
 
You need to ensure that the refreshed results do not clash with any Excel 
functionality you add to the Excelsior report.  For example, you need to 
ensure that a change in the number of rows or columns in the results does 
not over-write any of your own formulae.  The safest way to do this is to use 
separate sheets for the inserted Market Insight objects. 
 

Formulae 
 
Standard Excel functionality will ensure that any formulae based on data in 
Market Insight Objects are updated automatically. 
 

Pivot Tables 
  
All pivot tables in an Excelsior report are automatically updated whenever 
you do a Refresh. 
 

Filters 
 
Unfortunately Excel does not refresh filters when the underlying data 
changes.  Some simple Visual Basic can be used to achieve this.  
 
 
 
 

  
 

 

 
                                Refresh Panel 
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Appendix 1 – Excel Functionality 
 

Named Ranges 
 
Individual cells and groups of cells can be given descriptive names.  These can 
be used in formulae to refer to the cells instead of using the row-column 
notation, such as A1:E1. 
 

Advantages 
 
Formulae are more readable.   

 For example “Sum(product_sales)” is more meaningful than 
“Sum(C1:C20)” 

 
Formulae automatically adjust if the number of cells changes in a named 
range.  

 If the number of products change, such that they are now in cells 
C1:C25, the named range can be redefined and formulae such as 
“Sum(product_sales)” need not be changed 

 
Reference data (e.g. the name of a system table, such as “Holidays”) can be 
easily modified.   

 Instead of writing formulae such as “vlookup(“Holidays”, $A1:$C10, 2) 
it would be better to use vlookup(Transaction_Table_Name, $A1:$C10, 
2) where Transaction_Table_Name is the name of a cell whose 
contents is the word “Holidays” 

 If the table name is changed, then it is only necessary to update this 
single cell, rather than all individual formulae 

  
 
Using Named Ranges 
 
Create the named range: 

 Select the cell or cells to name 

 A useful short cut is to select the cell you wish to name and also an 
adjacent cell containing the text to be used as the name.  More 
powerfully, you can select say a whole table including the column 
headers, to name each column with the column header.  Click Ctrl-Shift-F3 

You can now use the name in a formula instead of the cell reference.  You can 
click on the cell name in the formula bar and Excel will highlight the cell or cells 
that the name relates to. 
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The example opposite shows the range of cells that relate to the inserted cube.  
This block of cells has the name: 
 
“FSO_Table_Todays_Destinations_652...” (which is the name of the Market 
Insight Object with a unique identifier appended). 

 
 
 
This named range can be used for example in formulae or as the source data 
for a chart.  For example: 
 

 Sum(FSO_Table_Todays_Destinations_65265de6578b47b9b0df1e571fdf4295) 
 

 Or paste the Reference in the Source Data box for a chart. 
 
 
Any changes in the size of the data inserted by Market Insight will be picked up 
by formulae or charts referring to the data via the named range. 
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Useful Functions 
 
The following functions are useful for creating reports to look up and reference areas of a workbook. 
 
 

Function Description  

 

GetPivotData()  Extracts the value of a specific data field from a pivot table, 
matching a number of criteria based on the rows and columns. 

 =GETPIVOTDATA("Sum(Cost)",A$1, Year",2007,"Destination",”Sweden”) 

 

Match()  Finds the position of a value within an array of cells  

=Match($C$19,Month_Names,FALSE)    [C19 contains month to find, Aug] 

 

Index() Picks a value from an array of cells, according to its position. 

=INDEX(Field_Names,C20)     [C20 contains value 3 = 3rd item] 

 

Vlookup() Picks a value from a block of cells according to a lookup value and 
an offset value. 

=VLOOKUP(“Aug”,Target_Values,3,FALSE)   [Use False for exact match] 

 

Offset() Picks a value from a block of cells according to 2 offset values. 

=OFFSET(Table_Corner,8,3)   [Row first, then Column] 

 

Indirect() Picks a value from a cell using the name of the cell. 

=INDIRECT(C25)      [C25 contains the name or reference of a cell] 

 

   

 


